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1. Introduction  
 
Since summer 2011, Age UK has been supporting and encouraging the 
development of a number of radio clubs in Dorset for older people.  
 
Bournemouth University, with the support of ADM-HEA, is exploring potential 
models for a ‘Community Hub’ whereby the university forms links between 
community radio groups, hospital radio, local and national BBC, organisations 
such as Age UK, and current students and graduates of the university.  
 
In October 2011, Mair Bosworth and Hannah Rolfe, two recent graduates 
from the MA Radio Production course at Bournemouth University, were 
contracted as researchers to investigate potential models for the Community 
Hub and to investigate how Bournemouth University students, staff and 
graduates could support the development of community radio in Dorset.  
 
2. Key Activities 
 
Our first introduction to members of the Dorset radio clubs established and 
fostered by Age UK came at a BBC-led training day in November 2011.  
 
BBC Training Days 
Two members of the BBC’s outreach team, producers at BBC London, 
delivered two days’ of training for members of the Dorset radio clubs, as part 
of a BBC initiative that offers staff different opportunities to work and connect 
with the public (http://www.training-skills-guidebook.info).  

 
The workshops were attended by local people from 4-5 Radio Clubs across 
the Dorset area including Purbeck, Christchurch, Shaftesbury and Dorchester 
groups.  The main aim being to introduce novice radio makers to the basic 
technology and terms used in creating a short radio package.  
 
The BBC trainers, together with Jo Tyler of Bournemouth University, provided 
an overview of: 
 

‐ How to make recordings with a handheld digital recorder 
‐ Interviewing technique 
‐ Recording vox pops with members of the public 
‐ Basic editing using Audacity free editing software 
‐ Editing content together into a package 
‐ Potential platforms for broadcasting their finished work 

 
Following the training days, Hannah and Mair followed up with two of the radio 
clubs to assess their development needs and ensure the BBC training was 
put into practice.  
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The Radio Clubs: Origins, Aims & Objectives 
Working with the Christchurch and Purbeck groups, Mair and Hannah began 
attending club meetings whenever possible and started to explore models for 
the support of the clubs. 
 
These two groups had quite different origins and aims. The Christchurch 
group was interested in citizen journalism and looking at how radio could be 
used within their local community for social cohesion and charitable aims. The 
Purbeck group was born out of the Purbeck Writers Group and thus had a 
literary, creative bent – their objective was to make creative radio features and 
poetry programming, such as that one might hear on BBC Radio 4.  
 
While Age UK had been involved in getting these clubs started, sadly the 
charity was not able to continue with its support for and facilitation of the club 
due to funding and staff cuts. 
 
Both groups were primarily composed of people 60+, with a couple of younger 
members. In these initial monthly meetings, we got to know the groups and 
began to ascertain what the interests, needs and concerns of the clubs were 
and ascertained that training was the main barrier to progress.  
 
Community Hub Training Days 
In February 2012, Mair and Hannah delivered a one-day training session to 
each of the radio clubs (see Appendix 1 for sample agenda).  
 

 
 
We followed up on some of the areas addressed in the BBC training days and 
gave an introduction to basic radio production skills for those radio club 
members who had not been able to attend the BBC training days.  
 
 
 
 
 
 
 



  4 

 
 
Feedback from the clubs (gathered via anonymous questionnaires) was very 
positive but there was a sense that training and support needed to be ongoing 
if the transfer of skills was to be sustained: 
 

“I understand much more about editing, cutting, moving, inserting than 
before. A big thank you. ”  
 
“It was useful being hands on with the equipment but I feel I would need 
constant use of the recording equipment in order to familiarise myself” 

 
Ongoing Support for Clubs 
Our involvement with both clubs has continued beyond the initial training and 
period of the research funded by ADM-HEA. We continue to act as ‘mentors’ 
and facilitators for both groups.  
 
Hannah created a quick guide to recording, editing and mixing using free 
software Audacity for use by the club members. See Appendix 4.  
 
Christchurch Radio Club are quite autonomous and only occasionally come to 
us with queries regarding recording equipment or production technique but we 
have become more closely involved with the Purbeck Radio Club and 
continue to attend their meetings regularly. We have provided further ad-hoc 
training and advised on programme-making.  
 
3. Training and Support Needs 
Our time with the clubs has given us a good understanding of what the key 
training and support needs of community radio clubs may be, especially those 
composed of older people. We surveyed the clubs via anonymous 
questionnaires to ask about their training and support needs. Common 
responses included: 
 

‐ Access to recording equipment 
‐ Access to computers 
‐ Access to recording studios 
‐ Help accessing sources of funding 
‐ Training in using recorders and microphones 
‐ Training in interview technique 
‐ Training in digital editing 
‐ Training with computer technology generally 
‐ Advice on selecting and shaping programme ideas 
‐ Advice on programme format and structure 
‐ Feedback on drafts of pieces made by the club 
‐ Advice on how to get the programmes broadcast 

 
4. Barriers to Progress 
The key factors preventing the groups from progressing their projects include: 



  5 

 
‐ Lack of confidence 
‐ Access to equipment: not just recording equipment but computers, 

storage devices etc. The groups need access to microphones, 
recording devices and a designated computer (or ideally several) for 
editing – some people have audacity on their home PCs or laptops but 
most machines are quite old and slow and there is concern they won’t 
be able to handle large audio files. They have discussed purchasing a 
computer but where would it be kept? The group would benefit from 
linking up with a community radio station or accessing the university’s 
facilities on an occasional basis 

‐ Too many ideas and lack of focus: as the groups have no leader as 
such, they have struggled to pick which ideas to focus on and take 
forward 

‐ Politics – a large proportion of time in meetings is often spent 
discussing the governance structure of the club(s) and contentious 
community issues such as closure of local healthcare facilities or 
redundancies. Perhaps too much community and not enough radio?! 
Some people want to see the individual radio clubs within Dorset unite 
as a network as a single ‘Dorset Radio Club’ or ‘Dorset Mature 
Broadcasters’ with regional branches. They feel this would give the 
organisation greater leverage in terms of seeking funding or securing 
commissions. While there is some acceptance of the benefits of joining 
together there seems to be a lot of inter-region rivalry and animosity! 
Christchurch and Dorchester in particular appear to be in conflict. 
There is a sense amongst some clubs that everything in Dorset is too 
Bournemouth-centric. The Christchurch club are keen to develop their 
own group first before joining with others 

‐ Equality of provision: outlying radio clubs in north and west Dorset are 
feeling left out of the loop! 

‐ Structure of clubs: lack of charitable status and lack of bank account 
will make fundraising problematic. C’Church Radio Club is set up as a 
project within the C’Church Community Partnership, meaning they can 
have a bank account but they have control of their own governance 
and finance. This is a useful model for other clubs 

‐ Computing skills generally (some club members have excellent 
computing skills but others have little or no knowledge of how to work 
with computers so simple aspects of radio production such as 
transferring files from a portable recorder to a computer can be 
challenging) 

‐ Lack of direction/leadership: with Age UK no longer in a position to 
offer support to individual groups, the clubs feel that they are 
floundering somewhat. They initially responded to an ad to “join a radio 
club” and now they feel they are being asked to lead the club activities 
themselves. They want someone to lead the groups or at least facilitate 
their development 

‐ Different agendas: some club members see the clubs as a means to 
produce professional, paid work and get their technical skills up to 
speed, others are seeking a pleasurable, occasional hobby and do not 
want too much commitment 
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‐ Lack of clarity around how the clubs are constituted and the need to set 
themselves up as a legal entity to pursue funding has caused some 
anxiety. If more information had been made available to them from the 
outset, this would have been helpful to the clubs 

‐ Concern over legal issues such as using music/readings (royalties etc) 
and getting consent from contributors 

‐ Accessibility: some of the club members are partially sighted or have 
mobility issues. This needs to be considered when providing training 
and in planning going forward. Some people cannot read from the 
screen so need printed copies of training manuals in large print, for 
example  

 
5. Recommendations: Potential Models for the Clubs  
Working with two of the clubs closely over the past months has given us a 
good understanding of the objectives, ideas, hopes and concerns of 
community radio clubs in Dorset. 
 
As far as we see it, there are a number of potential models going forward: 
  

1. Clubs seek to develop their own networks and take full responsibility 
for developing their own skills and securing funding [NB: the danger is 
that the clubs will lose momentum and enthusiasm without someone to 
guide and support them in their learning] 

2. Clubs forge links with other community partners such as heritage 
organisations or hospital radio stations. C’church Radio Club have 
forged links with a local museum, The Red House, which has a small 
number of good quality portable recorders it uses for oral history 
recordings and is willing to lend the club. C’church have also linked up 
with Hospital Radio Bedside in Bournemouth, who have expressed an 
interest in working with the club. This could be an interesting model for 
the Community Hub. 

3. Students and recent graduates from BU could provide ongoing 
technical support and advice. This would need to be formalised so the 
clubs’ expectations are met. 

4. Each club could be assigned a volunteer mentor – ideally someone 
who is experienced in the area of radio they are interested in – who 
could visit on a monthly or bimonthly basis to give advice. 

5. The clubs could fundraise for a project facilitator role to develop the 
project on a part-time basis. This could be one person, part-time, giving 
support to the several clubs and coordinating joint actions (such as 
funding bids or web development) for the clubs as a group 
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6. Broadcast Platforms  
With the clubs now producing packages and longer programmes, it’s vital we 
consider how and where this work will be broadcast. There are several 
options: 
 

‐ One possible model is that the clubs act as independent production 
companies, pitching one-off programmes or series to local community, 
commercial and BBC stations (see Appendix 3 for a full list) 

‐ Vintage Radio, Age UK’s radio station, is happy to play any 
programmes generated by the groups and they will be added to the 
MBA library of programmes 

‐ The clubs could develop a website, either individually or as a group 
under the banner “Dorset Radio Club” to stream audio 

‐ Bournemouth University could host content for the clubs, options 
include: 

‐  
• Using the stream for Logic (undergraduate online radio station) 

while it is offline during the summer months 
• Creating a webpage for the Radio Clubs within the BU domain 
• Creating an area within Birst for the Radio Clubs 

 
‐ The clubs could make their work available as a Podcast 
‐ The clubs may at times make work to meet a specific brief from an 

organisation such as The Environment Agency or NHS. These bodies 
would then have the responsibility for disseminating the content – 
either via existing radio stations or audio hosted on their websites 

‐ The clubs are also keen to use radio skills to work with the local 
community to produce content that may not need to be broadcast. E.g. 
one of the Cchurch members is keen to use radio with her Scouts and 
Guides to engage them in thinking about their environment and 
communicating with one another   

 
7. Potential Sources of Funding  
For the clubs to be sustainable, we need to identify sources of funding to 
cover costs of equipment, access to studios, travel costs incurred while 
making pieces, training and more.  
 
Age UK has supplied a small amount of ‘seed funding’ to each of the radio 
clubs. They were invited to apply for £150 to make a programme of their 
choice (with the understanding that the money could be used to buy kit).   
 
Other potential sources of funding include: 
 
Big Lottery Fun: Awards for All 
 

‐ Grants of between £300 and £10,000 
‐ Need a bank account  
‐ Application must be sent 3 months before project starts 
‐ Project to be completed within a year 
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‐ Do not need to be a registered charity but you would need a written 
governing document  

‐ You must show how your project meets at least one of them to be 
considered for a grant: 
 

• People have better chances in life – with better access to 
training and development to improve life skills 

• Stronger communities – with more active citizens working 
together to tackle issues within the community 

• Improved rural and urban environments – which 
communities are able to better access and enjoy 

• Healthier and more active people and communities 
 

Call us with any questions you may have on 0845 4 10 20 30 or email us at 
general.enquiries@awardsforall.org.uk or visit our website at 
http://www.awardsforall.org.uk/england 
 
Dorset Community Foundation  
 
http://www.dorsetcommunityfoundation.org/apply-for-a-grant/dorset-county-
community-fund/ 
 
Local Businesses 
 
Other Charitable Trusts and Foundations 
 
The clubs could approach small trusts and foundations with an interest in 
funding work benefiting the elderly, the local area, community cohesion, 
media and the arts.  
 
Dorset Partnership for Older People 
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8. Appendices 
Appendix 1: Training Day Agenda 
 
Essentials of Radio Production  
Purbeck Radio Club 
2nd February 2012 
 
10.45-11.30 Introduction and Listening Exercise 

- Content vs treatment: ways of telling, types of radio  
 

11.30-12.00 
 

Structuring a radio piece 
‐ Building Blocks 
‐ Planning your recordings and running order 
‐ Production Process 
‐ Scripting around your content 

 
12.00-13.00 Demonstration of recording technique  

‐ What questions to ask 
‐ Practice interviewing and capturing atmos in pairs  

 
13.00-13.30 Lunch 

 
13.30-14.00 Getting started with Audacity  

‐ Installing Audacity and the Help manual 
‐ Transferring recordings to your PC/Laptop  
‐ Opening files for editing  

 
14.00-15.30 Introduction to audio editing with Audacity  

‐ De-umming audio 
‐ Editing down a long piece of audio 
‐ Combing recordings from several sources 
‐ Working with multiple tracks to layer sounds  

 
15.30 Close Questions and Action Points!  
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Appendix 2: Sample Contributor Consent Form 
Purbeck Radio Club – Contributor Consent Form 
 
Thank you for agreeing to contribute to our radio programme.  It is our current 
intention that the programme will be first broadcast on …………………… on 
Age UK’s Vintage Radio station and it may be broadcast on other community 
radio stations in due course. 
 
This form gives Purbeck Radio Club the right to use the whole or part of your 
contributions.  We very much hope to use your contributions, but we cannot 
guarantee to do so. 
 
I confirm that I, the undersigned, agree to give Purbeck Radio Club my 
unrestricted permission, to distribute and exhibit, in any media, known or 
future, all still photographs, motion-picture film, visual recordings and sound 
recordings of me or my artistic work, for the production tentatively titled:  
 
 
………………………………………………………………………………….. 
  
I irrevocably and unconditionally grant to you all consents required pursuant to 
the Copyright, Designs, and Patents Act 1988 Part II or otherwise under the 
laws in force in any part of the world to exploit such performances.  
  
I irrevocably and unconditionally waive all rights which I may have in respect 
of the work pursuant to the Copyright, Designs and Patents Act 1988 Sections 
77, 80, 84 and 85.  
  
I consent to the use by Purbeck Radio Club of my name, likeness, voice and 
biography in connection only with the work.  
  
I understand that the production is being produced for a community radio 
project and not for financial gain.  
  
 
 
Name…………………………………………….  
 
  
Signed…………………………………………..           Date    ……...……  
 
  
Address 
……………………………………………………………………………………  
 
 
…………………………………………………………………………………………
Thank you once again for your assistance. 
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Appendix 3: List of Radio Stations (FM & DAB) in the Dorset/ Hampshire 
Area 
 

• Absolute Digital 60s, 70s, 80s, 90s, 00s, Classic Rock (DAB) 
http://www.absoluteradio.co.uk 

• Angel Radio 101.1FM  (Community, Isle of Wight) 'Europe's leading 
nostalgia radio station for older people', 'Snap, Crackle, but no pop', 
'Radio by Older people...for older people' www.angelradio.co.uk 

• BBC 1, 2, 3, 4 FM + DAB 
• BBC 4xtr, 5live, 6music, Asian Network DAB 
• BBC Solent 96.1FM + 103.8FM + DAB http://www.bbc.co.uk/solent/ 
• Capital (DAB) http://www.capitalfm.com/ 
• Classic 100-102FM + DAB + Online http://www.classicfm.co.uk/ 
• Fire Radio DAB + Online www.fireradio.co.uk 
• Forest FM 92.3 (Community, Verwood) 'East Dorsets first 

Community Radio Station', http://www.forestfm.co.uk/ 
 
'Forest FM pride themselves on bringing you the best music, without limiting 
themselves  with one particular era or genre. At Forest FM, we break the 
week up into three distinct sections. 
Weekdays we take a subtle blend of classic soft rock tracks and add in a 
lively assortment of oldies to conjure up a sound that is both sophisticated and 
interesting. Evenings are turned over to a terrific variety of specialist music 
designed for wide appeal.  
Weekends provide an opportunity to continue our interesting mix of sounds 
throughout the day. Programming is designed to appeal to families, catering 
for both our younger audience and our more mature listeners.  
Within this framework we fit an extensive range of community programming 
including news, interviews and specials. Put together, we deliver a true variety 
of music that provides a fitting back-drop to a refreshing local community radio 
station.' 
 

• Gold DAB 
• Heart Dorset 102.3FM + Online http://www.heart.co.uk/dorset/ 
• Heart South Coast 96.7 + 97.5 FM + Online 

http://www.heart.co.uk/southcoast/ 
• Hope FM 90.1 + Online http://www.hopefm.com/ (Community, 

Bournemouth) '... broadcasting on 90.1 FM in Bournemouth, Poole, 
Christchurch & surrounding areas and also streaming live around 
the world. We aim to offer a mixture of positive and uplifting music 
and chat, highlighting all that is relevant to our local community. 
With a message of Hope we truly offer 'Life-Changing Radio' 

• Jack FM 106 (Solent) 'Playing what we want' www.jackradio.com 
• Kiss DAB http://www.totalkiss.com/ 
• Planet Rock DAB http://www.planetrock.com/ 
• The Bay 96.9, 102.3, 103.2 FM + Online www.thebay.co.uk 
• Unity 101 FM + Online http://www.unity101.org/ (Community, 

Southampton) 'the South's only Asian and Ethnic Community Radio 
Station' 

• Voice FM 103.9 + Online www.voicefmradio.co.uk (Community, 
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Southampton) 'the Education Station' 'Welcome to Voice FM Radio 
 
Other examples of Community stations 
 

• Bradford Community Broadcasting www.bcbradio.co.uk (106.6FM, 
Bradford) 

• Resonance FM, online at www.resonancefm.com (104.4 FM, 
London) 'the art of listening' 

• Soundart Radio, online at www.soundartradio.org.uk (102.5 FM, 
Totnes) 

• Vintage Radio, online at www.vintageradio.org.uk (The Wirral) 'the 
grown up choice' 

 
Platforms 
 
FM (Community / Local / Commercial / RSL) 
AM 
DAB 
Online (Streaming / Podcasts) 
 
As we can see there are already a number of established Community Radio 
Stations available across the Dorset and Hampshire area (Hope, Forest, 
Unity101, Voice, Angel Radio), with Angel Radio being the only one that is 
designed to be 'radio by older people...for older people'.  However, each 
station could be contacted and used as possible platforms for group created 
material.  They also, along with the other stations mentioned above, all make 
use of internet radio, which can connect them to a greater audience outside of 
their main catchment area.  The benefit of internet radio for our project 
participants is that they have the ability to record a number of programme 
types, which are not confined to one length, style or genre.  For example, they 
may choose to stream live / pre-record magazine type shows, but they might 
also wish to create a set of podcasts, for example.  The benefit of this is that 
they can create programmes, build a fan base and work towards building 
skills and an ideas database that could possibly aid application for a 
Restricted Services Licence (RSL) in the future.  Stations like Forest and 
Hope worked with RSL's before attaining full Community Station accreditation 
from Ofcom, so if the aim is for to achieve this one day, then it would seem to 
be a good direction to follow. 
 
Regarding scheduling, there are a few good examples of shows that are led 
by the idea of Stories and Telling.  From what we know so far, there is a vast 
array of history and experiences that the Radio Clubs wish to portray using 
the medium of sound and there are a number of ways that we can help in 
facilitating them.  Both by teasing the stories from them and by helping them 
shape the way in which they wish to present them to their audience.   
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Appendix 4: Guide to Recording and Editing 
 
The Quick Reference Editing Crib Sheet 

 
Preparation: 
 

‐ Think about your subject.  What are the top 3-5 questions you could 
use to record suitable voxpops?  Who, What, Were, Where, Why 

‐ Research -  Know your subject.  Think about treatment; who will you 
interview and why? 

 
Recording: 
 

• Turn on device 
• Best to use an external microphone for better sound quality 
• If mike lead is quite long wrap it around your hand to avoid it 

banging against equipment and causing handling noise 
• Likewise remember to hold the mike firmly and steadily 
• Mike is best positioned between yourself and the interviewee, at 

chest level should suffice, but play around.  Angle towards the 
subject by slightly tilting your hand.  Gently tilt towards yourself if 
you require your voice / questioning on the recording, but remember 
to tilt back to subject when they speak 

• Eye Contact!!  Hard at first when remembering to check levels and 
that device is recording, but will improve with practice.  It's 
appropriate to show an interest in what your interviewee is telling 
you.   

• Avoid 'mmm's' and 'ah ha's' etc.  Difficult to edit out and you will get 
annoyed when playing back, believe me.  Just keep gentle eye 
contact, not a mad stare, and the odd nod of encouragement. 

• Be open.  Genuine 
• To save time when editing, you can pause your recorder when you 

ask a question then simply press resume to captor the reply 
• It's common sense to check all your equipment before attempting 

any type of recording.  So check your batteries and if needs be 
carry spares.  Check the recording device settings are set to the 
right input (any external device, e.g. mike, needs to be inserted and 
synced into the recording device so that it knows where to pick up 
the sound from), i.e.; on the Tascam DR-07 the mike was in the 
'Mic2' slot and there should be a settings switch located somewhere 
on the device where there'll be a choice to select desired input (if 
not then you could always google for help or check instruction 
manual) 

• On the Tascam press the record button once to put device on 
standby (red light flashing), then play/pause to start recording (solid 
red light).  By pressing play/pause again the device will return to 
standby.  By keeping the red light active you will be recording onto 
one track.  Should you press stop at any time, the next time you do 
record it will be to an entirely new track 

• Wait for a reply, remember silence can be a powerful tool 
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Uploading recordings to your computer: 
 

• Connect device to computer. (Some devices require turning on in 
order to connect) 

• If a folder does not appear on the Desktop try checking in My 
Computer 

• Create a folder for your work where ever you wish to save then, 
then like copying work from a USB stick, simply select the files that 
you wish to transfer and drag them into your newly created folder. 

• Safely eject your recording device 
• For those of you new to the idea of copying folder a simple way is to 

place the cursor over the file you wish to copy > select file by 
pressing the left mouth button > once selected file is highlighted, 
press the right mouse button > a pop up selection box should 
appear.  In this box should be the word 'Copy', click on it. now go to 
the folder where you wish to place the copied file > in the empty 
white space of the opened folder area place the cursor > right click 
with the mouse > this time select 'paste'. Your selected file should 
now appear in the new folder, ready for use 

 
Editing (with Audacity): 
 
Open Audacity 

 
 
 
Opening a File within a project:  
 
File > Import > Audio – Select raw material you wish to work on from file – 
Open  (remember, 'Open' will open a new Audacity File (aup.), 'Import' will 
open your file in the current project, but on a new Track) 
 

‐ Always listen to any recorded material before you begin the editing 
process.  This way you can begin to know what it is you want to keep 
and what you want to throw away, saving time in the editing process 
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Cutting:  
 
Using the mouse click the cursor arrow on the beginning line of the section 
you wish to cut. If you hold the mouse over the line a hand will appear, by 
clicking, holding and dragging this line you are able to highlight the section 
you require. This selection can be neatened up at either end by using the 
hand tool.   
 

 
 

 
 
Once you are ready, hit the delete button on your keyboard. 
 
Undo! Undo!: 
 
Like any editing software there is an 'Undo' button under the 'Edit' tab at the 
top of the screen, as well as a quick Undo in the form of the circular 
backwards arrow on the top tool bar. 
 
Volume:   
  
Situated just to the left off centre on the top tool bar are six buttons.  In normal 
edit mode the button which looks like an 'I' should be selected.  For volume 
editing, select the button to the right of this, which should feature a blue line 
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with two white arrows at the top and bottom. Adjust points on the track lines to 
manually adjust the volume. 
 
 

 
 
Alternatively you can select your area of adjustment and effect > Amplify 
 
Copying a selection:  
 
Again, highlight the selection you wish to copy (like when deleting), then either 
use Edit > Copy on the computer screen, or press Control (Ctrl) + C on the 
keyboard 
 
Pasting a selection:  
 
Place the cursor / time-line on the track where you roughly want to paste it, 
then either Edit > Paste, or press and hold Ctrl + V. 
 
New Tracks:   
 
Should you wish to use a number of layers within your production, or copy 
and paste required selections into a separate track click on; Tracks > Add 
New > Stereo. 
 
You can easily delete an unwanted track by clicking on the  'X' that sits in the 
top left hand  corner of  each individual track. 
 
Zoom in / out:  
 
Top tool bar > magnify glass with + / - in centre (+ = in / - = out).  If nothing 
is selected the whole project will be affected, or select a section and zoom in / 
out for closer editing work. 

 
 
Fade In / Fade Out:   
 
Select and highlight where and how much you want to fade in or out.  Click 
edit > fade in / fade out.  Audacity will complete the rest automatically. 
 
Alternatively you could use the Volume control button as discussed above. 
 
To split a track:  
 
Place the time line where you wish to separate the track, then, Edit > Split or 
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click on Ctrl + I. 
 

Normalising: 
 
To control peaking within tracks and to, in theory, bring all sounds to an even 
level. However, be careful when using this as many influences can cause the 
sound to interfere, i.e., background noise etc. 
 
edit > select > all 
effect > Normalise (probably best between -1db - -3db) 
 
Saving: File > Save Project as (For first time saving) or Save Project (if 
updating your save).  This will save the work as what is know as an aup. file 
(like a doc. File for Word etc.), which is only specific to Audacity and unlikely 
to be opened on any other software. 
 
'When you open Audacity for the first time, it automatically opens a 
new, empty project. To begin, you'll want to make sure that you 
give the project it's own name and folder location for file 
management purposes. Then you'll know where the files are saved 
and stored for your project. To do this is simple: from  the main 
menu, select File and then Save Project As. 

 
 

The Basics: Setting Up a Project 
 

The Save As window is displayed, prompting you for a filename for 
your project. 

 
Type a file name, and then click on Save. 
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You'll notice that there are now two files in your save location: an 
AUP file with  your project name, and a directory or folder named 
project name_data. 
 

 
The .aup file is the Audacity-specific project file, and is what you 
would select  to reopen your project once you have closed it. The 
data folder is exactly as it is named - a data directory that Audacity 
uses to store all of the recorded audio and changes that you make 
to the .aup file. 

 
Remember, these are file names and types that only Audacity 
recognizes. 

 
Once you have recorded and edited your audio to make it sound its 
best, you will Export and save into a common audio format like 
MP3. 

 
As you work in Audacity, recording, editing, and working on your 
audio track, it is always good practice to save your project often, so 
that you don't lose any of your hard work. This is as easy as 
clicking on File, and then selecting Save Project from the main 
menu. 

 
Save shortcut keys: 
 
You can also use the Save Project shortcut keys on your keyboard 
when you want to save your project. For the Windows operating 
system you  would use Ctrl + S. Within MAC OS X, use Command 
+ S.' 
(Hiitola Pg 23.  2010) 
 
File > Export:  
 
This will enable you to save the work as a wav. file (a less compressed and 
better version of an mp3. music file), into a folder of your choice.  It will mix all 
your edited tracks together so ten tracks, for example, will become one track.  
A wav. can be opened in other editing software and music players such as 
iTunes / Realplayer etc. 
 
Know your WAV from your MP3 
 
'WAV files are uncompressed, high-quality pulse-code modulation 
(PCM) files. They are large. One minute of a CD-quality stereo 
WAV recording consumes about 10MB of disk space. WAV is the 
best-supported format and is the quality standard by which other 
formats are measured. 
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MP3 (MPEG-1 Audio Layer 3, not MPEG -3) is a popular 
compressed, lossy encoding format; an MP3 file can be as small 
as one-tenth the size of a simalar WAV file and still sound pretty 
good. This means you can cram a lot more music into a portable 
player and have faster downloads and better online streaming. The 
trade-off is that quality is lost.' 
(Schroder 2011) 
 
Recommended Reading / 
Bibliography; 
 
The Book of Audacity:  Record, Edit, Mix, 
and Master  
with the free audio editor 
Carla Schroder 
No Starch Press:  San Francisco 
2011 

 

 
 
Getting Started with Audacity 1.3 
Bethany Hiitola 
Packt Publishing 
Birmingham – Mumbai 
2010 
 
 
 
 
 
 

 
Key things to remember when building your package: 
  
1. Context 
2. Tell a story – through line 
3. Set the scene 
4. Mixture of voices 
5. Sound effects 
6. Music (it's important to remember that voices should not fight to be heard 

above  background music, but that the two should work together for 
effect and atmosphere) 

7. Narrated or not? 
8. Beginnings, Middle and End 
 
 
 


